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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures
CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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As at 31 December 2020

Equity Indices Monthly Performance in
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December 2020

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Equity Index Futures Access Codes
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-2.1%
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+1.8%
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HS Mainland
Properties Index

HS Mainland
Oil & Gas Index

HS Mainland
Banks Index

HSCEI

HSI

% Change

Index Name

+1.8%

+3.7%
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+6.1%

HSCEI

CES120 Index

CSI 300 Index

FTSE A50 Index

% Change

Index Name

Vendor HS Mainland Banks

HS Mainland 

Properties

HS Mainland

Oil & Gas CES 120 HSI HSCEI

Bloomberg BMWA PPTA OGIA CESA HIA HCA

Refinitiv 0#HMBI: 0#HMPI: 0#HMOI: 0#HCHH: 0#HSI: 0#HCEI:

WIND MBIF MPIF MOIF CHHF HSIF HHIF

ET Net MBI MPI MOI CHH HSI HHI

Data Source: Bloomberg

Information for reference only



Hang Seng Index (HSI) Futures & Options

Equity Index Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

HSI Futures (YoY) HSI Options (YoY)

HSI Futures (MoM) HSI Options (MoM)

As at 31 December 2020

HSI Products 

(2020 vs 2019)
ADV OI*

HSI Futures 167,209 (-20%) 129,721 (+7%)

Mini-HSI Futures 112,057 (+24%) 17,370 (+63%)

HSI Options 39,405 (-22%) 162,843 (-22%)

Mini-HSI Options 13,436 (-1%) 8,638 (-52%)

HSI Volatility 

Index Futures
1 (0%) 0 (-100%)

HSI Dividend 

Point Index 

Futures

101 (+80%) 3,860 (+103%)
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HSI Futures & Options

Equity Index Futures & Options
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Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 31 December 2020

Hang Seng Index

 Includes the largest and most 

 liquid stocks listed in Hong Kong

 Index Level  27,231.13 (As at 31 Dec 2020)

 Index Volatility (30-Day Historical)  21.8

 Index Avg. Day High-Low Range  220.59 (Dec 2020)

 HSCEI Correlation (2020)  0.962

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$1.36Mn (As at 31 Dec 2020)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 01 Dec 2020  HK$86,150

Hang Seng Index Futures

 Index Description

HSI & Top 5 Constituents

Distribution of HSI Index Options OI in Month-end
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Hang Seng China Enterprises Index (HSCEI) Futures & Options

Equity Index Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

As at 31 December 2020

HSCEI Futures (YoY) HSCEI Options (YoY)

HSCEI Futures (MoM) HSCEI Options (MoM)

HSCEI Products 

(2020 vs 2019)
ADV OI*

HSCEI Futures 145,608 (+5%) 290,518 (-11%)

Mini HSCEI 

Futures
18,227 (+22%) 4,197 (0%)

HSCEI Options 83,236 (-5%) 1,502,474 (-28%)

Mini HSCEI 

Options
2,266 (-4%) 3,490 (-73%)

HSCEI Dividend 

Point Index 

Futures

1,802 (-17%) 52,667 (-55%)
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HSCEI Futures & Options

Equity Index Futures & Options

7

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 31 December 2020

HSCEI & Top 5 Constituents
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HSCEI

Comprises the largest and 

most liquid H shares

 Index Level  10,738.40 (As at 31 Dec 2020)

 Index Volatility (30-Day Historical)  22.1

 Index Avg. Day High-Low Range  93.44 (Dec 2020)

 Correlation with HSI, CES120 (2020)  0.962,0.891

 Correlation with CSI300, FTSE A50

 (2019)
 0.762,0.799

 Contract Multiplier HK$50

 Notional Value (1 Contract)  HK$0.54Mn (As at 31 Dec 2020)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 01 Dec 2020  HK$34,650

HSCEI Futures

 Index Description

HSI vs HSCEI 

Distribution of HSCEI Index Options OI in Month-end



Weekly HSI & HSCEI Options Performance
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Data Source: HKEX

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 31 December 2020

An investment tool to manage short term event risk

Weekly HSI & HSCEI Options Volume
Contract Multiplier  HK$50

Liquidity Providers
 Akuna, Eclipse, I-Access, IMC, Maven, 

Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Contract Multiplier  HK$50

Liquidity Providers
 Akuna, Eclipse, I-Access, IMC, Maven, 

Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Weekly HSI Options

Weekly HSCEI Options
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Single Stock Futures & Options

Equity Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

As at 31 December 2020

Stock Options (YoY)Stock Futures (YoY)

No. of Single Stock Derivatives

Single Stock Futures 81

Single Stock Options 101

Stock Futures

• Products

 3 A-shares ETFs futures contracts

 Total 81 stock futures contracts

Latest and Future Developments

Stock Options

• Products

 3 A-shares ETFs options contracts

 Total 101 stock options contracts

• Market Makers (MMs)

 3 types of market makers (PMM/ CQMM/ 

QRMM)

 CQMM to provide 50 series continuous 

quotations

Stock Futures (MoM) Stock Options (MoM)
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Single Stock Derivatives ADV (2020 vs 2019) ADV OI*

Stock Futures 4,585 (+23%) 22,965 (-16%)

Stock Options 526,191 (+19%) 8,942,852 (+33%)



MSCI Asia and Emerging Market Index Futures Performance
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Data Source: HKEX

* Exclude commission fees

Information for reference only

As at 31 December 2020

Volume and Open Interest continue to growthFutures contracts have relatively lower transaction costs

MSCI Asia and Emerging Market Index

representation 38 DM and EM countries and

regional indices

 Contract Multiplier Average US$40

 Notional Value (1 Contract) Average US$49K (As at 31 December 2020)

 No. of Liquidity Providers 14

Stamp Duty  N/A

Trading Fee  US$0.6-US$1.0 / contract

SFC Levy  US$0.07 / contract

 Transaction Cost*

MSCI Asia and Emerging Market Index Futures

 Index Description

Open Interest (31 December 2020)

Average Daily Volume (31 December 2020)
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance
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Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference only

As at 31 December 2020

MSCI AxJ Combines Developed and Emerging Markets (Rebased  to 100)

MSCI AxJ is a well-established benchmark representing Asia 

regional (excluding Japan) equity market performance
Futures contracts have relatively lower transaction costs
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Open Interest

 MSCI AxJ

representation 2 DM countries (excl. Japan)

and 9 EM countries in Asia

 Index Level  636.87 (As at 31 December 2020)

 Index Volatility (30-Day Historical)  20.5

 Index Avg. Day High-Low Range  4.64 (December 2020)

 HSI Correlation (2020)  0.918

 HSCEI Correlation (2020)  0.919

 Contract Multiplier  US$100

 Notional Value (1 Contract)  US$64K (As at 31 December 2020)

 Avg. Quote Size  US$0.32Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  1.0 index points (December 2020)

 Liquidity Providers Flow  and 11 banks

Stamp Duty  N/A

Trading Fee  US$0.5 / contract

SFC Levy  US$0.07 / contract

Margin as of 01 Dec 2020  US$2,310

 Transaction Cost*

 MSCI AxJ Futures

 Index Description
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Hang Seng Mainland Banks Index Futures Performance
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 31 December 2020

Index & Constituents 3-Month Performance (Rebased to 100)

HSMBI Futures can be used for hedgingFutures contracts have relatively lower transaction costs

 Hang Seng Mainland Banks Index (HSMBI)

 10 largest and most representative 

 HKEX-listed mainland banks stocks

 Index Level  2,693.23 (As at 31 December 2020)

 Index Volatility (30-Day Historical)  23.0

 Index Avg. Day High-Low Range  29.92 (December 2020)

 HSI Correlation (2020)  0.773

 HSCEI Correlation (2020)  0.819

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.13Mn (As at 31 December 2020)

 Avg. Quote Size  HK$0.67Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  64.2 index points (December 2020)

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 01 Dec 2020  HK$7,440

Transaction Cost*

 Hang Seng Mainland Banks Index Futures

 Index Description
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0.18%
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0.25%

0.25%

0.38%

0.38%

0.39%

0.43%

0.61%

1.58%
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HSMBI Futures
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Hang Seng Mainland Oil & Gas Index Futures Performance
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 31 December 2020

Index & Constituents 3-Month Performance (Rebased to 100)

HSMOGI Futures can be used for hedgingFutures contracts have relatively lower transaction costs

 Hang Seng Mainland Oil & Gas Index (HSMOGI)

 7 largest and most representative 

 HKEX-listed mainland oil & gas stocks

 Index Level  1,006.43 (As at 31 December 2020)

 Index Volatility (30-Day Historical)  36.7

 Index Avg. Day High-Low Range  14.31 (December 2020)

 HSI Correlation (2020)  0.713

 HSCEI Correlation (2020)  0.697

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$50K (As at 31 December 2020)

 Avg. Quote Size  HK$0.25Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  51.7 index points (December 2020)

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 01 Dec 2020  HK$4,310

Transaction Cost*

 Hang Seng Mainland Oil & Gas Index Futures

 Index Description

0.16%

0.34%

0.42%

0.47%

0.50%

1.26%

2.52%

CNOOC 883.HK

Sinopec Corp 386.HK

PetroChina 857.HK

China Oilfield 2883.HK

Kunlun Energy 135.HK

BG Blue Sky 6828.HK

HSMOGI Futures
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Hang Seng Mainland Properties Index Futures Performance
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 31 December 2020

Index & Constituents 3-Month Performance (Rebased to 100)

HSMPI Futures can be used for hedgingFutures contracts have relatively lower transaction costs

 Hang Seng Mainland Properties Index (HSMPI)

 10 largest and most representative 

 HKEX-listed mainland properties stocks

 Index Level  6,035.89 (As at 31 December 2020)

 Index Volatility (30-Day Historical)  31.7

 Index Avg. Day High-Low Range  57.26 (December 2020)

 HSI Correlation (2020)  0.81

 HSCEI Correlation (2020)  0.836

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.30Mn (As at 31 December 2020)

 Avg. Quote Size  HK$1.5Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  123.1 index points (December 2020)

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 01 Dec 2020  HK$19,800

Transaction Cost*

 Hang Seng Mainland Properties Index Futures

 Index Description
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HSMPI Evergrande (3333.HK)
China Overseas (688.HK) Country Garden (2007.HK)
China Res Land (1109.HK)

5-Min Avg. Bid-Ask Spreads (31 December 2020)
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 31 December 2020

0.06%

0.06%

0.10%

0.11%

CSOP FTSE A50 ETF (2822.HK)

ChinaAMC CSI300 ETF (3188.HK)

CES120 Futures

X iShares A50 ETF (2823.HK)

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

CES120 Futures have relatively tighter Bid-Ask Spreads

Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

5-Min Avg. Bid-Ask Spreads (31 December 2020)

80

90

100

110

120

130

Oct-2020 Nov-2020 Dec-2020

CES120 Index Tencent CCB

Ping An China Mobile

 CES120 Index

 80 A-Shares and 40 HK-listed Mainland

 China H-shares, P-chips, and red chips

 Index Level  8,458.78 (As at 31 December 2020)

 Index Volatility (30-Day Historical)  18.7

 Index Avg. Day High-Low Range  77.22 (December 2020)

 CSI300 Correlation (2020)  0.914

 FTSE A50 Correlation (2020)  0.926

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.42Mn (As at 31 December 2020)

 Average Quote Size  HK$2.11Mn (5 Contracts)

 Average Bid-Ask Trading Spread  8.3 index points (December 2020)

 Liquidity Providers  Flow

Stamp Duty  N/A

Trading Fee  HK$5 / contract

SFC Levy  HK$0.54 / contract

Margin as of 01 Dec 2020  HK$20,640

Transaction Cost*

 CES120 Index Futures

 Index Description
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Data Source: HKEX

Information 

Vendor

MSCI Australia 

NTR (USD) 

Index Futures

MSCI China 

Free (USD) 

Index Futures

MSCI China 

Free NTR 

(USD) Index 

Futures

MSCI EM Asia 

ex China NTR 

(USD) Index 

Futures

MSCI EM Asia 

ex Korea NTR 

(USD) Index 

Futures

MSCI EM Asia 

NTR (USD) 

Index Futures

MSCI EM 

EMEA NTR 

(USD) Index 

Futures

MSCI EM ex 

China NTR 

(USD) Index 

Futures

MSCI EM ex 

Korea NTR 

(USD) Index 

Futures

MSCI EM 

LatAm NTR 

(USD) Index 

Futures

Bloomberg HKCA Index HMSA Index HJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index HQIA Index HQYA Index

Refinitiv 0#HMAN: 0#HMCU: 0#HMCN: 0#HMAC: 0#HMAK: 0#HEAN: 0#HMEE: 0#HMXC: 0#HMXK: 0#HMEL:

WIND MANF.HK MCNF.HK EANF.HK

Information 

Vendor

MSCI 

Emerging 

Markets (USD) 

Index Futures

MSCI 

Emerging 

Markets NTR 

(USD) Index 

Futures

MSCI Hong 

Kong NTR 

(USD) Index 

Futures

MSCI India 

(USD) Index 

Futures

MSCI India 

NTR (USD) 

Index Futures

MSCI 

Indonesia 

Index (USD) 

Futures

MSCI 

Indonesia NTR 

(USD) Index 

Futures

MSCI Japan 

(JPY) Index 

Futures

MSCI Japan 

NTR (JPY) 

Index Futures

MSCI Japan 

NTR (USD) 

Index Futures

Bloomberg HMPA Index HMOA Index HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index HQBA Index HJCA Index

Refinitiv 0#HMEM: 0#HEMN: 0#HMHN: 0#HMDA: 0#HMIN: 0#HMID: 0#HMDN: 0#HMJP: 0#HMJJ: 0#HMJU:

WIND MINF.HK MDNF.HK MJUF.HK

Information 

Vendor

MSCI Malaysia 

(USD) Index 

Futures

MSCI Malaysia 

NTR (USD) 

Index Futures

MSCI New 

Zealand NTR 

(USD) Index 

Futures

MSCI Pacific 

ex Japan NTR 

(USD) Index 

Futures

MSCI Pacific 

NTR (USD) 

Index Futures

MSCI 

Philippines 

(USD) Index 

Futures

MSCI 

Philippines 

NTR (USD) 

Index Futures

MSCI 

Singapore 

Free (SGD) 

Index Futures

MSCI 

Singapore 

Free NTR 

(USD) Index 

Futures

MSCI 

Singapore 

NTR (USD) 

Index Futures

Bloomberg HMYA Index HKEA Index HOPA Index HRPA Index HRBA Index HNSA Index HLEA Index HKOA Index HOBA Index HKPA Index

Refinitiv 0#HMMY: 0#HMMN: 0#HMNZ: 0#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: 0#HMSG: 0#HMGN: 0#HMSN:

WIND MMNF.HK

Information 

Vendor

MSCI Taiwan 

(USD) Index 

Futures

MSCI Taiwan 

25/50 (USD) 

Index Futures

MSCI Taiwan 

25/50 NTR 

(USD) Index 

Futures

MSCI Taiwan 

NTR (USD) 

Index Futures

MSCI Thailand 

(USD) Index 

Futures

MSCI Thailand 

NTR (USD) 

Index Futures

MSCI Vietnam 

(USD) Index 

Futures

MSCI Vietnam 

NTR (USD) 

Index Futures

Bloomberg HJAA Index HRCA Index HRDA Index HJBA Index HMTA Index HKDA Index HNTA Index HKSA Index

Refinitiv 0#HMTW: 0#HTWP: 0#HTWN: 0#HMWN: 0#HMTH: 0#HMTN: 0#HMVT: 0#HMVN:

WIND MTWF.HK MWNF.HK MTNF.HK



Weekly HSI and HSCEI Options Access Codes
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Data Source: HKEX

MSCI AxJ and MSCI AxJ Futures Access Codes

Information Vendor Weekly HSI Options Weekly HSCEI Options

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name

Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <0#HSIW*.HF> <0#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

Hong Kong and International Information Vendors

Information Vendor MSCI AxJ Index MSCI AxJ Index Futures

AASTOCKS - 221495

Activ Financial - MXJ/<yy><m>.HF

Bloomberg M1ASJ Index MJSA Index CT

CQG - MXJ

DB Power - MXJ

East Money Information - MXJ

Factset - MXJE

ICE Data Services - F:MXJ

Infocast - MXJ

N2N-AFE - 870823

QPWeb - P11203

SIX Financial Information - MXJmy

Refinitiv .MIAX00000NUS 0#HMXJ:

Telequote Data - MXJ/<yy><m>.HF

Tele-Trend - MXJFC, MXJmyy

Hong Kong and International Information Vendors



Sector Index and Sector Index Futures Access Codes
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Data Source: HKEX

Information Vendor Mainland Banks 

Index

Mainland Banks 

Index Futures

Mainland 

Properties 

Index

Mainland 

Properties Index 

Futures

Mainland Oil 

& Gas Index

Mainland Oil & 

Gas Index 

Futures

AASTOCKS 221420 221425 221415

Activ Financial =0200700.HK MBI/16K.HF =0200800.HK MPI/16K.HF =0201000.HK MOI/16K.HF

AFE 837451 870809 837451 870810 837451 870808

Bloomberg HSMBI Index BMWA Index MSMPI Index PPTA Index HSMOGI Index OGIA Index

DB Power MBI MPI MOI

ET Net MBN MBI MPR MPI MOG MOI

Infocast HSMBI MBI MSMPI MPI MOGI MOI

QuotePower SEHK.HHSMBI P11223 SEHK.HHSMPI P11224
SEHK.HHSMO

GI
P11222

Telequote MBImy MPImy MOImy

Refinitiv .HSMBI 0#HMBI: .HSMPI 0#HMPI: .HSMOGI 0#HMOI:

Hong Kong and International Information Vendors

Mainland Information Vendors

Information Vendor Mainland Banks 

Index

Mainland Banks 

Index Futures

Mainland 

Properties Index

Mainland 

Properties Index 

Futures

Mainland Oil 

& Gas Index

Mainland Oil & 

Gas Index 

Futures

East Money HSMBI MBI HSMPI MPI HSMOGI MOI

Hexin Flush Financial MBIC MPIC MOIC

Pobo Financial
MBI+Month+Ye

ar
MPI+Month+Year

MOI+Month+Ye

ar

Qianlong 999905 209 999902 209 999903 209

Wind HSMBI
MBIF+yymm+H

K
HSMPI MPIF+yymm+HK HSMOGI

MOIF+yymm+H

K



CES120 Index and CES120 Index Futures Access Codes
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Data Source: HKEX

Information Vendor CES 120 Index CES 120 Index Futures

Bloomberg Finance L.P. CES120 CESA Index DES <GO>

Refinitiv .HKCES120 0#HCHH:

AAStocks.com Limited 110056 221360

AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH

Infocast Limited CE120 CHH

Interactive Data Group I:CES120 Fn:CHH\MYYDD

Marketprizm Hong Kong Limited CES120 CHHmy

SIX Financial Information Ltd. CES120 CHHmy

Telequote Data International Limited CES120 CHHmy

Hong Kong and International Information Vendors

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code

Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK

Zheng Zhou Esunny Information Technology Co, 

Ltd.
- CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209


